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HGSI software and EdgeRater are independently powerful stock
market analysis programs. When used together you have a
combination that is more than the sum of its parts. An incredibly
powerful duo of programs working together to show everything
you need to arrive at your trading decisions.

This document explains how to set up HGSI and EdgeRater to
work together and discusses some of the things that you can do
with this combination of products.



Using HGSI to generate Symbol Lists for EdgeRater
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The Goal: Export any HGSI Group to use as a Symbol List in EdgeRater

Groups in HGSI can be used as Symbol Lists in EdgeRater, there are two ways to achieve this:

1.
2.

Export from within the HGSI Designer
Export from within the HGSI Warehouse
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Export from the HGSI Designer
Designer->File->ASCII Utilities->Export Groups As Lists
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Exporting a group from the HGSI Designer

In the HGSI Designer, choose the group you want to use as a symbol list in EdgeRater
Select ‘File’

Select ‘ASCII Utilities’

Select ‘Export Groups As Lists...’
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A new dialog box will pop up, the settings should be as follows:
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Settings to use when exporting from the HGSI Designer



1. Browse to the EdgeRater Symbol Lists Folder:

{Documents}\EdgeRater\Symbol Lists

Location will be remembered next time you do an export

& Save As
T , « Documnents » EdgeRater » Symbaol Lists
Organize » Mew folder
¢ | g Desktop *  Mame
4 | Documents .
| All Securities 51, 250K bt
4 || EdgeRater o
|| Finviz Gold Stocks.td
» ) Chart Scripts o
|| Finviz Silver Stocks.txt
» ) Configuration . . .
|| High Probability ETF Tradin...
> . EdgeClub ] ]
L || LeavittCommuodityETFs.bet
e || LeavittSectorETFs.txt
. Reports )
|| LeavittWorldETFs.tet
» ) Selectors
= S&P 15000t
| Snapshots )
' || Sector ETFs (iShares).tet
. Symbol Lists
- || Select Sector (SPDR) ETFs.tet
@ My Music
* @ My Pictures v £

File name: | 58P 1300.td

Save as type: | Text files

“ Hide Folders

v 0 Search Symbol Lists 2
= w |ﬁ|
Date modified Type Size
472372000 11:39 AM Texdt Document
111472014 12:46 ... Text Document
111472014 12:47 ... Text Document
31072015 %35 AM Text Document
107472014 6200 AM Text Document
0272015 8:56 AM Text Document
107472014 6:05 AM Text Document
4232016 11:20 AM Text Document
9/9/2014 %12 AM Text Document
G/9/2014 5:50 PM Text Document
>
W
W

Save

Cancel

N

Browse to the EdgeRater Symbol Lists Folder

Exclude HGSI Indexes from the export

3. Use the ‘Symbol, Name’ format for export

E

Press OK




Export from the HGSI Warehouse
The second way to export symbols from HGSI to use as a symbol list in EdgeRater is from an HGSI Warehouse View. Only
the symbols in the view will be exported, so if the view defines a filter you will only get the symbols that pass the filter.
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Exporting Symbols from a Warehouse View

1. From the HGSI Warehouse, select ‘File’
2. Select ‘Save List As’
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Browse to the EdgeRater Symbol Lists Folder




3. Locate the EdgeRater Symbol lists folder: {Documents}\EdgeRater\Symbol Lists
4. Type a meaningful name for your list
5. Press Save

Note that the file extension applied when you export a warehouse view as a list is .Ist. It doesn’t matter to EdgeRater
whether the file extension is .Ist or .txt (as exported by the designer). The contents of the exported files have the same
format and EdgeRater will automatically make these lists available in the program.

Here's what the contents of the .Ist file looks like:

) S&P 1500.ist - Notepad — O
File Edit Format Wiew Help
FOXA,215t Centry Fox A Cm ~

FOX, 215t Centry Fox B Cm

DDD, 3D Systems Corp

MMM, 3M Company

EGHT,8%X8 Inc

AADN , Aaon Inc

AIR,AAR Corp

AAN, Aaron's Inc

ABAX, Abaxis Inc

ABT,Abbott Laboratories
ABBV,Abbvie Inc. Common Stock
ANF , Abercrombie & Fitch Company
ABMD, Abiomed Inc

ABM, ABM Industries Incorporated
AKR,Acadia Realty Trust

ACN, Accenture Plc

ACET,Aceto Cp

ACIW,Aci Worldwide Inc

ACOR, Acorda Therapeutics
ATVT Artdsvrdicinn Rliz7and

Contents of the exported list file

Notice that the format is Symbol, Name. This is the same format that we specified when exporting from the designer.
The warehouse export uses this format automatically so we don’t need to perform the extra step of specifying the
format like we did in the designer. However, the Designer will remember the format that we specified for next time and
so we won’t actually need to specify it again there anyway.

Summary
EdgeRater can use any file contained in the {Documents}\EdgeRater\Symbol Lists folder as a symbol list providing it is in
the correct format (Symbol, Name).

HGSI allows you to export groups of symbols from the Designer and Warehouse view to the EdgeRater symbol lists
folder. Once you have performed that step the symbol list will automatically appear within the EdgeRater program.



Getting End Of Day (EOD) Price History for a symbol list

Once you have exported a file in the correct format to the EdgeRater Symbol Lists folder, it should appear in the Symbol
Lists dropdown control:
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The EdgeRater Symbol Lists DropDown control

1. Press the Symbol Lists dropdown control to locate the exported list



If you have not used this particular list before, the ‘Symbol Data’ area will be blank:
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Price history Data has not been downloaded yet



Press the EOD Update button to get historical price data for your new list
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EOD Update Button gets price history from provider

Once data has been updated, the main area of the symbol lists panel will be populated with the symbol, name and the
To date representing the date of the last bar that was downloaded. If the Time field contains a time instead of saying
EOD it means that you pressed the ‘Intraday Update’ button instead which fetched the last bar as a 15 min delayed bar
from Yahoo.



Default Data Provider
Each Symbol List in EdgeRater is associated with a data provider. If you haven’t set a specific data provider for a symbol
list, then when you press the ‘EOD Update’ button the data will be fetched from the system-wide ‘Default Data
Provider’. HGSI Users are recommended to set the Default Data Provider to HGSI.
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Setting the System-Wide Default data provider to HGSI

Go to the ‘Home’ menu tab
Press ‘Data Providers’
Select HGSI (only available if you have HGSI Installed)



Symbol List Data Provider Overrides

Each list can override the default data provider and get data from a specific provider such as Yahoo. If you don’t set a
specific override the data will come from the default provider. To see where the data is actually coming from , default
or override, you can press the ‘Edit List’ button.
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Overriding the default data provider for a symbol list

1. Press ‘Edit List’ button
2. Inthe ‘Symbol List’ tab, choose the desired data provider for the symbol list



Archive View

One of the most powerful and time-saving features of the integration between HGSI and EdgeRater is the ‘Generate
Indexes from Warehouse’ template which requires a warehouse archive view (containing all warehouse fields) and a ‘No
Filter’ filter applied. You can import this view into your HGSI software.

The file to import can be found by going to

http://www.edgerater.com/sharedfolder

and searching for the Integrations->HGSI Folder.
There you will find a filter to import (.flt) and a warehouse view to import (.whs).

Download both of these files to your desktop and then use the HGSI program import functionality to import the Filter
and Warehouse view.


http://www.edgerater.com/sharedfolder

Importing the Filter:
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File name: | EdgeRaterFilters_20160504.flt ¢l | HGSI Filters (*flt) v

Importing the EdgeRater Filters into HGSI

Press the Filter button

Select the root Filters folder
Press the Import button
Locate the downloaded .flt file
Press Open
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Importing the Warehouse View:

# HGSI Warehouse - 1483 securities, filter used: Top Down Analysis, VPA Indexes, combo rank: Top Down Analysis, VPA Scoreca.. — &
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File name: | EdgeRater\WarehouseViews_20160504.whs v | |HG5l Warehouse Views (".whs) v

Importing the EdgeRater Warehouse Views into HGSI

In the Warehouse, select ‘Choose/Create View’ button
Select the root Warehouse Views Folder

Press ‘Import’

Locate the downloaded .whs file

Press ‘Open’

AR



Using the Archive View

The EdgeRater Archive View that was imported into HGSI in the previous section is used for archiving the current state
of the warehouse. Use this view on the ‘All Securities’ group. This information can be used by EdgeRater for many
different analysis tasks:

e EdgeRater can automatically generate and fetch price history for an ‘All Securities” symbol list.
e EdgeRater can automatically generate 10 year indexes for the following groups:

e Industry Group

e Major Industry Group
e Sector Group

e S|C Code Group

Once you have these 10 year indexes you can run them against EdgeRater templates. One example is to find out
the seasonality of the various industry groups (by running the Annual Trends templates)

e The EdgeRater warehouse report can report on which ERG values have performed best/worst since the report
was saved, as well as which A/D letter rank and HGS Box performed best and worst.

In order for EdgeRater to use this Archive view it needs to be saved from HGSI to your file system as an HTML file.

Saving the warehouse as an HTML File

e HGSI Warehouse - 8341 securities, filter used: no filter, combo rank: Top Down Analysis, VPA Scorecard = B
File Tools Help
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1 5 Y'ear HiYld Corp Bond lds ETF Pim ] - - - ~
2 SHYG 05 ear High ield Core [shares 1 Quick Pick Warehouse Views [ | 5
3 STIP 0-5%'ear Tips Bond Ishares : |Search | ®| 55
4 CLY 10+ Year Credit Bond |shares : - 36
5 ILTE 0+ ear Government/Credit Bond [ghar 1= EI Warehouse V'e‘_"s 5
B TLH 0-20%'ear Treasury Bd [shares 1 =01 EdgeRater Yiews, 20160504 1.87
7 CSJ 3 'ear Credit Bond |shares ! 2 %1, 250K 61
(=] SHY 1-3%'ear Treasury Bond Ishares : FR Archive Yiew 33
) TUZ 1-3%'ear US Treasury Index ETF Pimco 1 £ =5 SOET=PRs an
10 PLWw 1-20 Laddered Treasury Powerzhares ] +|=_~| HGSI Starters a1
] ESC 347 Capital Cp Comm {51 HESI Volume Price Analysis, 20160329 i
2 FSCR 347 Capital Cp Rght : £ 1an Woodward & Ron B 50160329 3
E] FSCU J47 Capital Cp Urit ] + an Woodwar on brown, 50
14 [TFSCW 1347 Capital Cp War ] -0 Jeffrey Scott 3
15 PIH 1347 Property Inz Cm ] +-23 Lary Connors i
1B STRZ 1-5%'ear US Tips Index ETF Pimco j +-21 Morales & Kacher, 20160329 29
7 |I:TF'Z 5+ Vear US Tips Index ETF Pimco 1 +-C31 Ron Brown, 20160501 12
g FL'WS -800-Flowers. Com i ﬁ Uszer Views v
] FCTY St Century Bancshs : - 39
I 15t Canstitution Bep ] +EB Defaul View ]
41 SHCE 15t Source Corp L S T
22 MLPS 12 Short Alerian MLP [nfr ETHW UBS E-T 2583648 0194470 08/02416 |13.38
23 RS 20+ 'ear Trsy Bear 1% Diresion Z3536.97 -3.573419 05/02416 |20.85
24 b 20+ Vear Trey Bear 3= Direxion 38497 79 -8.396300 05/02/1E6 |22.02
25 rF 20+ Year Tray Bull 3= Direxion 16147.01 5.240243 05/02/16 |B9.36
25 BSCG 2016 Carp Bond Bulletshares Guggenhei 2EVE2EY -0.080345 05/0241E | 22,05
27 BSJG 2016 HY' C Bd ETF Bulletshares Guggenh 20679.10 -0.361955 05/02/16 |25.77
28 IBME 2016 S&P Amt-Free Municipal Ser |shar 1E557.91 -0.248700 05/02/16 |26.28
29 BSCH 2017 Corp Bond Bullstzhares Guggenhe 2023774 -0.034264 05/02/16 [22.69
30 I—BSJH 2017 HY' C Bd ETF Bulletshares Guggenh LT E2 0.243495 05/0241E |25.70
3 |IEMF 2017 55P Amt-Free Municipal Ser Ishar 1827393 0101652 05/0241E |37.37 v
< 3

Choosing the Warehouse Archive View and All Securities group

1. Inthe HGSI Warehouse make sure you have the ‘All Securities’ group selected.
2. Press the ‘Quick Pick’ Views button
3. Choose the Archive View from the EdgeRater Views



pi] HGSI Warehouse - 8341 securities, filter used: no filter, combo rank: Top Down Analysis, VPA Scorecard = [=]
File Help
Choose Group... & @ % ‘
Copy Symbols To Clipboard ' lgner  Charting Ranking Report Filter Help
+ pe
Meke Group From List AltG Securities ~ | View: [ Archive View v = | gj &l | ‘ ‘ #h 2| | ’
Append to Group...
Symb Mame Faw Combo R ank Raw RS Last Date Last
Add Securities To QuoteTracker.., H ond Idx ETF Pim
SHYG 0-5 Year High *rield Care | shares 2396019 -0.455666 05/02/16 [45.60
grpedioiMeTastoc kol G STIP 5 Vear Tips Bond [shares 2893896 0.401072 05/02/16 [100.55
Save Ac CLY 0+ 'ear Credit Bond Ishare_s 2253035 1.938305 05/02416 |59.86
ILTE O+ Year Government/Credit Bond [shar 1772411 1.897667 05/0216 [62.85
I Save As HTML... TLH 0-20 Year Treasury Bd Ishares 12150.21 0.972190 05/02416 [139.87
= C5J -3*vear Credit Bond Ishares 2814437 0.155286 05/02416 | 105.51
flimiies SHY I ¥ear Treasuy Bond lsharss 2230015 0.023859 05/02/16 [84.53
. TUZ -3 ear US Treasury Index ETF Pimco 2416822 -0.017466 05/02416 [51.00
Print Snapshot... PL'w -30 Laddered Treasury Powershares 2116467 0.954332 05/0246 |33.51
Save Snapshot As... FSC 347 Capital Cp Comm 2845039 21855982 05/02/16 [9.90
FSCR 347 Capital Cp Raght 3307514 -4 4BE163 05/02/16 |0.33
Close FSCU 347 Capital Cp Uit 35409.60 2994372 04/23416 |10.50
FSCw 347 Capital Cp'war 18514.53 -28.000002 04/27/16 [0.16
8 FIH 347 Property Ihs Cm 3377450 -B.723643 05/02/16 |5.90
[ STPZ B 'vear US Tips Index ETF Pimco 3322145 0.335159 05/02416 |52.29
7 LTPZ 5+ ‘rear US Tips Index ETF Pimca 14010.72 1.613747 05/02/16 |BE.02
a FLWS -800-Flowers. Com 11001.86 -4.753880 058/02/16 |7.67
9 FCTY St Century Bancshs 2516873 21.058628 05/02416 |10.93
20 FCCY 5t Constitution Bop 19539.09 4.014150 05/02/16 [12.50
21 SHCE St Source Cop 3360369 E.1377E2 05/02416 |34.74
22 MLPS # Short Alerian MLP Inft ETN UBS E-T 2583648 0.134470 05/02416 |13.38
23 BS 20+ Year Trsy Bear 14 Direxion 23636.87 3573413 05/02/16 |20.85
24 [k 20+ ear Trsy Bear 34 Direxion 3849779 -8.396300 05/02416 [22.02
25 MF 20+ ear Trey Bull 3= Direxion 1614701 5.240243 05/02416 |89.36
26 SCG 2016 Corp Bond Bulletshares Guggenhei 2E782 87 -0.080845 05/0246 |22.06
27 SIG 2016 HY C Bd ETF Bulletshares Gugagenh 20679.10 -0.367955 05/02416 | 26.77
28 BME 2016 SEP amt-Free Municipal Ser lshar 1655791 -0.248700 05/02416 | 26.38
23 SCH 2017 Corp Bond Bulletshares Guggenhei 20837 74 -0.034264 05/0246 |22 B3
30 SdH 2017 HY C Bd ETF Bulletshares Gugagenh 2375222 0.243495 05/02416 | 25.70
£l BMF 2017 SEP &mt-Free Municipal Ser lshar 18273.99 0101652 05/02416 | 27.37 v
< >

Saving the Warehouse Archive View as an HTML File

4, Press ‘File’
5. Press ‘Save As HTML...”

Save As

(—) - T « EdgeRater » HGSl » Warehouse Archive v | O Search Warehouse Archive 2
Organize Mew folder - (7]
4 | Documents Date modified Ty
4 | EdgeRater Create this folder _
. Chart Scripts structure if it iterns match your search,
> Configuration doesn't exist
4 EdgeClub
4 HGSI
. Warehouse Archive
Legs v £ >
File name: | All Securities.htm W
Save as type: | HTML files W

= Hide Folders

Save Cancel

Saving the Warehouse Archive View (Choosing the folder to save to)




6. Create a folder structure to store this html file

a. Create afolder named ‘HGSI’ underneath {Documents}\EdgeRater

b. Create a folder named ‘Warehouse Archive’ under the new ‘HGSI’ Folder
7. Choose a filename for the html file (All Securities.htm is good)
8. Press Save



Using this data in EdgeRater

Once you have saved the warehouse HTML file from HGSI you can close HGSI. EdgeRater can do all kinds of cool things
with this data providing you have your EdgeRater Default Data Provider set to HGSI. The most important template to run
to make use of this data is the ‘Generate Indexes From Warehouse’ template.

Generate Indexes From Warehouse

TR EdgeXcel™ Templates - EdgeRater PRO Unleashed > B
| |
- Home EdgeXcel™ Templates (7]
¢ B = == i on| 2364 | munpste || E
‘k/ Lj L:‘] v Latest Version i Run Date H i E
Pro Save As Open Template Open Report Open Favorites My Version m Get Latest Run Video Template
Watch List L _ Templates Help Info
Version | File | Watchlists | Download Templates | Run Template | Help |
_(T AS v | Generate Indexes From Warehouse HTML Template Library
Ei
g a [ B ] ¢ | o | E | °F G H | I | res
g1
& — R 'l' r This Excel document is a Trading Template that can be MName i
] o R ETF Trading
—— run inside EdgeRater trading software products. Code Blue
3 ] with
EdgeXcel™Template Technology Code Red
4 http://www.edgerater.com — ;
s pi// & A VPA Signals Bollinger
T Hindenburg Omen Report Bands
- High Jump for Nasdag
| 7| Generate Indexes From Warehouse HTML ETF Trading wi...
P Warehouse Report
3 Generate Indexes From Warehouse
10 Convert Warehouse HTML
11 | This template generates 10 year indexes of Industry Groups, Major Industry Groups, Sectors and SIC Code Group History Analysis q oo
15 |Groups using an HGSI warehouse html file, To generate the warehouse file from HGSI, go to HGSI Warehouse, " | Alpha21 Symbol List Ranker : e
— | select the following view: lan Woodward and Ron Brown->01 Top Down Analysis->09 Archive view. Then | %8 Buckets Report
select File->Save As HTML and save the file to a known location on your hard drive. Once you have the T country ETFs 5
warehouse file saved you can select it in this template via the Change Settings button, then just press Run. || Couniry EIFS Summary Woodward & E5
13 US Markets Summary
| | ; Short Selling
14 |Warehouse File: |<Press Change Settings Button to Set> || Woody VIX Analysis
15 | %L Sector ETFs Summary Stocks
16 Change Settings 2x & 3x Bear ETFs Summary with
17 23 & 3x Bull ETFs Summary ConnorsRSI
18 — ¥ Short Selling 5...
44 » m]y Template Info/Ce { /Parameters | < >

EdgeXcel™ Templates |E§ Chart Designer ]5'_‘)Entries and Exits @ Trade Simulation

x Completed  17441.58 ms

Using the ‘Generate Indexes From Warehouse’ Template

1. In EdgeRater, locate the HGSI Category of Templates

2. Find and select the ‘Generate Indexes From Warehouse’ template

3. Press ‘Change Settings’ and locate and open the warehouse html file just saved (note that on future runs the
settings will be remembered and so you won’t need to press ‘Change Settings’ next time. Just ensure that the
Warehouse File field is pointing at the right file.



@ TR EdgeXcel™ Temnplates - EdgeRater PRO Unleashed =
| |
Home EdgeXce|™ Templates (’)
¢ E = = c on[ 264 | [Runvate  [-] E
“/ L_:] , o Latest Version | 2016.4 i Run Date H i E
Pro Save As Open Template Open Report Open Favorites My Version Get Latest Run Video Template
Watch List Templates Help Info
Version | File | Watchlists | Download Templates | Run Template | Help |
_(T A5 v || Generate Indexes From Warehouse HTML Template Library B x
El
g a [ B ] ¢ | o | E | °F G H | I | res
" Ed
;' Warehouse Selection -
—1 2 | Code Blue ETF Trading
3 = | ith
— Select HGSI Warehouse HTML File Code Red L
2 EdgeXci — Bollinger
- VPA Signals g
5 | <Press Change Settings Button to Set= Browse — Band:
T Hindenburg Omen Report anas
7 ( High Jump for Nasdag
Warehouse Report ETF Trading wi...
8 | oK Cancel ]
3 ¥ | Generate Indexes From Warehouse
10 M| Convert Warehouse HTML
11 | This template gener o T
12 |Groups using an HGS . L
select the followmg\ @ - 1 . v ThisPC » Documents » EdgeRater » HGSI » Warehouse Archive v O Search Warehouse Archive 2
select File->Save As |
s warehouse file savec OmEnEeE New folder - @ @
. 18 This PC ~ ‘ ii iz
14 |Warehouse File: <I = This MName Date modified Type Size
=1 tu Desktop = -
15 - =] All Securities.htm 5/3/2016 6:20 PM HTM File 14,145 KB|
| | Documents
16
| . EdgeRater
17 -
— . Chart Scripts
18 ] .
4« » n]y Template Info  Configuration )
. EdgeClub -
7| EdgeXcel™ Ter | HGsI
. Warehouse Archive E
x L
J Logs
. Reports
- . 2
File name: | All Securities.htm ‘Warehouse Files (*.htm) W
@

Choosing the warehouse html file saved from HGSI

Press Browse

N oo s

Press ‘Open’

Locate the Warehouse Archive Folder created in the previous steps
Locate the All Securites.htm file saved from the previous steps




TR EdgeXcel™ Templates - EdgeRater PRO Unleashed > B
| |
‘_4 Home EdgeXcel™ Templates g
E & & L S -
Y A =] o Latest Version i Run Date - i E
Pro Save Az Open Template Open Report Open Favorites My Versi m Get Latest Run Video Template
Watch List HAs _ Templates Help Info
Version | File Watch Lists Download Templates Run Template Help
_(? A5 v ||Generate Indexes From Warehouse HTML Tem P \ B x
=i ress
o
E A B C D E F G H | ] ~ | &
i | | | | | Run
& — R 'l' r This Excel document is a Trading Template that can be MName d
] o R ETF Trading
—— run inside EdgeRater trading software products. Code Blue
3 | with
EdgeXcel™Template Technology m Code Red
4 http://www.edgerater.com/ — ;
s = & VPA Signals Bollinger
T Hindenburg Omen Report Bands
- High Jump for Nasdag
| 7 | Generate Indexes From Ware TML — ETF Trading w...
P || Warehouse Report
3 Ensure the } | Generate Indexes From Warehouse
10 fileis Convert Warehouse HTML
11 | This template generates 10 year indexes of Industry Groups, Maj selected d SIC Code Group History Analysis Wooche s
15 |Groups using an HGSI warehouse html file, To generate the wareho! GS| Warehouse, " | Alpha21 Symbol List Ranker ;m’ 3
— | select the following view: lan Woodward and Ron Brown->01 Top Dow, view. Then | %8 Buckets Report e B
select File->Save As HTML and save the file to a known location on yo rive. Once you have the | country ETFs S
warehouse file saved you can select it in this template via the Change ngs button, then just press Run. || Couniry EIFS Summary Woodward &8...
13 US Markets Summary
| | ; Short Selling
14 |Warehouse File:| C:\Users\Chris\Documents\EdgeRater\HGS\Warehouse Archive\All Securities.htm || Woody VIX Analysis
15 | %L Sector ETFs Summary Stocks
16 Change Settings || 2x & 3x Bear ETFs Summary with
17 2x & 3x Bull ETFs Summary ConnorsRS|
18 v Short Selling 5.,
44 » m[\ Template Info /Completed /Parameters | < > o K
37| EdgeXcel™ Templates |E§ Chart Designer ’5‘_-) Entries and Exits @ Trade Simulation
x Completed  17441.58 ms

8.
9.

Running the ‘Generate Indexes From Warehouse HTML’ Template

Ensure that the warehouse html file is selected (remembered from previous runs)

Press ‘Run’

Running this template will instruct EdgeRater to perform the following tasks:

a.

Convert the HTML file to a useable .xIsx spreadsheet file, named for the date of the data contained within, eg:

20160502 Warehouse All Securities.xlsx

Note that if you export a warehouse html file and run this template every day you will create a new archive xlsx
file daily that will contain the contents of the warehouse on that day. Great for keeping a record of all the rich

information you have in HGSI. These files are all openable and searchable within Microsoft Excel, but you don’t
need Excel in order to run EdgeRater.

b. Automatically create the following Symbol List

C.

e Warehouse All Securities

Automatically create 10 year indexes of the following groups

e Warehouse Indexes SIC

e Warehouse Indexes Major Industry
e  Warehouse Indexes Industry
e Warehouse Indexes Sector

These symbol lists and indexes now appear in the EdgeRater Symbol Lists Panel and can be used on any template that

requires a symbol list. For example, run the Seasonality Template on the ‘Warehouse Indexes Industry’ list.




When the template has finished running you will see the following information:

TR Ch\Users\Chris\Documents\EdgeRater\Reports\HG5|_Warehouse_Indexes -2016-05-03_06-34-07-PM.xlsx = B
I‘\I\'H__/-"I o
= . F :
"L} Lj @ % r" Open Favorites H]i EI H_Iﬂ Eg
Fro Save SaveAs Open  Alow Add To 6‘1—: Reset Favorites | View Chart  Create  Openlinked | Copy Column Insert Copied Trade
Editing Favorites Symbel List  Document Column Simulation = |
Versian | Report | Watch Lists | Tools | Copy Columnis | |
Af v || Index generation has completed and you should now find the indexes in the symbol lists area. Mote that these symbol lists should not be updated using the normal EQD
A | 8 | ¢ ol e | fF | & | W | v | 3 | k | L [ M | N »
1
Ex Ed el EO'I'er This Excel document is a Trading Template that can be
— run inside EdgeRater trading software products.
3
— ™
4 Edgexce'f Temp’ate Techno.r'ogy http://www.edgerater.com/
5

Index generation has completed and you should now find the indexes in the symbol lists
area. Note that these symbol lists should not be updated using the normal EOD or
Intraday update button. They must be re-generated daily by running this template again.

5]
| 7 | Warehouse Filename: | C:\Users\Chris\Documents\EdgeRater\HGSI\Warehouse Archive\All Securities.htm
| 8 | Warehouse Symbol List Name: | Warehouse All Securities.txt
| 9 |
10 Generated Index  Index Symbol List Name
11 Industry Group Indexes:| Warehouse Indexes Industry.txt
12 | Sector Indexes: 'Warehouse Indexes Sector.txt
113 | Major industry Indexes: |Warehouse Indexes Major Industry.txt
14 SIC Group Indexes: |Warehouse Indexes SIC.txt
15

Information displayed after a successful ‘run’ of the ‘Generate Indexes From Warehouse HTML’

template



If you open up the Symbol Lists panel dropdown you will see these new lists:

|j2|

- Home Edgel¥cel™ Templates

v B B8 =5 B
L

Pro Save As  Open Template Open Report Open Favor
Watch Lis
Version | File | Watch Lis
o || Symbol Lists B 3 |1se HT
(7 /2702 @
=
E Warehouse All Securities, tvt | = | 3'
Mame |
Sector ETFs (iShares). twt -~ b
» i Select Sector (SPDR) ETFs. txt T E
Warehouse All Securities. tet
: Warehouse Indexes Industry. txt L
Warehouse Indexes Major Industry. txt B
] Warehouse Indexes Sector, tit
] Warehouse Indexes SIC. txt B
S&P 1500.|st _|pe
B CBOE Weeklys, xlsx 1 I
B Liquid Options 100, xdsx F
: Liquid Options 500, xlsx h:
Masdag 100.csv
: SP100,csv E 1
=]
¥ 5TPZ 1-5Year ... 5/2/2015 EOQD
“| LTPZ 15+Year ... 5/2/2016 ECQD hd
8340 | T

Symbol Lists and data automatically generated by the template

Summary

HGSI Software Users can export an All Securities warehouse archive view as an HTML file and then use EdgeRater to
automatically generate indexes and symbol lists for use within the EdgeRater software program. This is achieved using
the ‘Generate indexes from warehouse HTML’ template. Doing this daily also ensures that you have a searchable history
of warehouse fields. The indexes and symbol lists produced can be run against any EdgeRater template to give insightful
information such as the Seasonality of the various Industry Group indexes or report of Industry Group Rotation.

EdgeRater can also use the archived files to show the performance of ERG stocks, A/D letter rank stocks and HGS Box
stocks over any period of time (via the Warehouse report template).



